Survival Skills for Leadership and Beyond

Presented by the ABA Standing Committee on Bar Activities and Services and the Division for Bar Services
Tip #1

Put your oxygen mask on first
Tip #2

Don't make promises
Tip #3

Create an electronic copy of your signature

Sign and fax or efile your documents without ever printing them.

See the tutorial https://www.youtube.com/watch?v=sBrfsVMN0GI
Tip #4

Leadership is servanthood
Tip #5

Focus on the important, not the urgent
Tip #6

Make a decision.
If you are wrong, make another one
Tip #7
Set reminders for email (that work)
Tip #8

It is about the bar’s legacy more than it is about your own
Tip #9
Initiate a Meeting with Doodle or FindTime
Tip #10

Use technology
Tip #11

Laughter is good. Laughing at yourself is even better
Tip #12

Look for dual impact opportunities
Tip #13

Presidential initiatives usually fail
Tip #14

Turn off your email and phone
Tip #15: Evercontact
Turn signature blocks into contacts

Outdated or missing contacts in your address book?
Your Contacts Always Up-To-Date Auto-Magically!

Start for Free Now >>

Find out more

ABA BAR LEADERSHIP INSTITUTE
Tip #16

You are an ambassador
Tip #17

The executive director is your partner
Tip #18

Be kind to yourself
Tip #19
Email – Exercise Caution

High-Profile Skadden Litigator Goofs, Sends Private E-mail to Reporters

February 5, 2008, 5:42 pm
Report: Lawyer’s Email Slip-up Leads to Zyprexa Leak

Mistaken 'reply all' email leads to suspension without pay for prosecutor

Oops. Former bar prez copies top court on email about its 'ill-conceived and uninformed questions'

ABA BAR LEADERSHIP INSTITUTE
Tip #20

Get by with a little help from your friends
Tip #21

You be you
Tip #22: Script Timer

Script timer

Today's lawyers face an array of electronic information tools. We've moved beyond the basics to a universe of information now available on the Internet. But what's needed to cope with that information is an understanding of strengths and limitations, of realities and myths, and a recognition that both today and for the foreseeable future lawyers will exist with a multiplicity of tools, conventional print, and web-based resources. The information that lawyers will need is not always available free of charge. Understanding where to spend your dollars on research and information is critical.

LEGAL RESEARCH ON THE 'NET
When using the Internet to conduct free legal research it is best to use focused legal research sites to start the project. Even then, the user must be aware of accuracy, authority, and whether the resource is up-to-date. Some of the best online legal research resources provide pathfinders or bibliographies to help the research get started. Always remember the mnemonic from the American

Spoken words per second

3.1

Estimated time to read script

2:00

Time yourself reading this script

Start
Tip #23

Make lists
Tip #24

No yelling ever!
Tip #25

Know your support systems
Tip #26

Watch your words
Tip #27
Task Management - Asana
Tip #28

The executive director is your co-pilot
Tip #29

The executive director’s job only looks easy
Tip #30: Hootsuite

Schedule. Manage. Measure.
Get the world's #1 platform for managing social media.
Tip #31

Your office staff are an extension of you and your presidency
Tip #32: Tripit

The travel app that keeps up with you
Get real-time flight alerts with TripIt Pro. Try it free for your next trip.

Start TripIt Pro 30-Day Trial  Learn More
Tip #33

Show up and come to play
Tip #34

Mentor as well as lead by example
Tip #35

Calendar everything
Tip #36: Portable Charger/Power Bank

- **powerstation USB-C XXL**
  - Newest MacBooks and devices with USB-C or USB-A connectors
  - 5 stars
  - $149.95

- **powerstation XL**
  - Smartphones, Tablets & USB Devices
  - 5 stars
  - $69.95

- **powerstation plus XL**
  - Smartphones, Tablets & USB Devices
  - 5 stars
  - $99.95

- **charge force powerstation**
  - mophie charge force cases, iPhone X, iPhone 8, iPhone 8 Plus & other wireless-charging smartphones
  - 5 stars
  - $99.95

---

**ABA BAR LEADERSHIP INSTITUTE**
Tip #37

Year-round Lenten practice
Tip #38

Act as though you are the 1st
Tip #39

You are never not the president
Tip #40

Leave fertile ground
10+ Tech Tips for Bar Leaders

FOR BLI 2018
BY CATHERINE SANDERS REACH

PRESENTED MARCH 16, 2018
Do you receive documents electronically that you need to sign and return? If you print them out, sign them, and scan them back in to return them electronically you can stop now! Watch this video to create a transparent signature stamp that you can use in Adobe Acrobat to sign documents without printing them.

Watch: [https://www.youtube.com/watch?v=sBrfsVMN0GI](https://www.youtube.com/watch?v=sBrfsVMN0GI)

Pro tip: If you are signing a PDF form print the document to PDF after you have inserted the signature to affix it and all the form fields to the document.

In Microsoft Word to insert the signature on a document with a signature line go to the Insert menu and in the Illustrations group choose "Pictures" (Insert – Illustrations – Picture). Find the image file of your signature and insert it close to the signature line in the document. Right click on the signature image to send the graphic behind the text under "order" and move the image over the line to make it overwrite the line.
If all eight fingers are occupied by strings it may be time to consider alternative ways to keep up with reminders. FollowupThen (http://www.followupthen.com) is a fast, simple, free program that works with any email on any device. Simply send an email (or forward an email) to xxxtime@followupthen.com where xxxtime is the time you want to be reminded. Consider – forward an email that doesn’t need action for two weeks to 2weeks@followupthen.com and folder the email. In two weeks the email will be sent to you with a note to follow up. Or send yourself a quick email reminder – something that doesn’t sit in your inbox but alerts you to take action. When you receive your reminder email you can set another reminder with a click. FollowUpThen Premium gives you SMS reminders, calendar integration, customized followups for your recipients, attachment support, a handy web interface for followup management and more.

Boomerang lets Gmail, Office 365 and mobile email app users (https://www.boomerangapp.com/) “boomerang” an email back into the inbox when you want it to arrive. It archives the original email in the Boomerang folder. It also reminds you when you have not heard back from someone you sent a message to. Basic versions are free.

Similarly TechHit (makers of SimplyFile and EZDetach) are rolling out the Snoozelt (https://www.techhit.com/Snoozelt/) Outlook add-on to let you act on a message in the future by hiding it from your inbox and having it re-appear on a date you choose. Snoozelt is $40.
When you need to initiate a meeting, it can quickly turn into a mess of emails without a resolution. Scheduling tools can help take out some of the hassle, and one that really stands out is Doodle (https://doodle.com/dashboard). Doodle creates meeting time polls you can send to recipients. Setting up an account is easy and free, and it’s available for mobile.

For Office 365 users you can see calendars for people in the firm, but what about outside? A free plugin called FindTime works much like Doodle, is free, and builds Doodle-like functionality into the Outlook calendar: https://findtime.microsoft.com/
Evercontact (https://www.evercontact.com/) works with Gmail, Google Apps, Outlook, Office 365, iPhones, and CRMs like Salesforce and Highrise. The software automatically creates and updates contacts from email signatures and sends them to your address book. Basic service for a single user is free, though there are group and Pro plans with more bells and whistles. One premium feature called “Flashback” looks at your email for the past five years and collects the contact information (that is, if you hang on to email that long) for a one-time cost of $99 or $49 for one year of analysis of your email archives. Evercontact will show you what it is adding and give you the chance to accept or reject it — so it isn’t so automatic that it fills your contacts with people you don’t want there.
Email – Exercise Caution

Just because we use it all day every day does not mean that people can get complacent about this form of communication. Employ a more formal “letter writing” approach, check your spelling, check the recipients, exercise caution, consider alternate communication mechanisms, and just slow down!

How do lawyers do this? Autocorrect in email applications provides a drop down list to choose from in the To:, CC: and BCC: fields. In MS Outlook you can turn that off and empty the list by going to File – Options – Send Messages – and uncheck the “Use Autocomplete” option.

Alternatively you can choose to let sent messages sit in the outbox for a time as a last chance “whoops” control.

Create a Rule in Outlook (Desktop Version)
If you’re an Outlook user, you can create a rule that will hold any email you send in an outbox for an amount of time that you can specify. Even ten minutes can make a big difference, particularly in tense situations where tempers might be involved. To create this rule:
1. Go to the File tab in the ribbon
2. Select Manage Rules & Alerts
3. Select New Rule
4. Under Start from a blank rule, select Apply rule on messages I send
5. Hit Next >
6. Select any conditions you want to apply. If you want it to apply to every email you send, just hit Next > (If you do not select any conditions, you’ll be given a message that says “This rule will be applied to every message you send. Is this correct?” Hit Yes and continue)
7. Select defer delivery by a number of minutes
8. In the window below the checklist, the selected action will appear and “a number of” will be hyperlinked. Click it
9. Defer delivery by however many minutes you choose
10. Hit Next>
11. Select any exceptions you want to apply and hit Next>
12. Name the rule whatever you choose. Make sure the box next to Turn on this rule is selected (you probably will not want to select the other two boxes) and hit Finish
13. Click OK
14. Click Apply

With that, you’re all set! If you want to delete or change this rule, repeat steps 1-2, highlight the rule in your list and select Change Rule or Delete.

**Undo Send in Gmail**

Gmail doesn’t have any options quite as sophisticated as Outlook, but it does have a feature called “Undo Send.” Don’t get too excited – it’s not a magical reversal button, but it does remain an option within 30 seconds of sending an email. That’s not a huge amount of time, but it’s usually long enough to recognize the more technical or minor mistakes you might have made. To activate this feature:

1. Click the gear icon in the upper right hand corner of your Gmail home screen
2. Hit Settings
3. In the General tab (where settings automatically opens), find Undo Send: and check the box that says Enable Undo Send
4. If you want even less time, you can select 5, 10, or 20 seconds (30 is the default)
5. Scroll to the bottom and hit Save Changes

When enabled, the yellow window that pops up at the top of the page (under Gmail’s native search bar) after sending a message will now include an Undo button for 30 seconds after sending.

**In Android**

Settings ‡ Delay email sending ‡ up to 5 seconds

These self-check tools may seem like a burden initially, but they’ll save you time and embarrassment in the long run.
Have you been asked to make “brief” remarks? While you want to seem spontaneous and natural, it is incredibly difficult to remain brief without a script. You will need to write out your script and then read it and time it. A handy free website: http://www.piehole.ie/pages/script-timer will let you copy and paste the text of the script and give you an idea of how long in minutes it would take to read it. Paste in your script, click “start” and read it then click “stop” to adjust for your reading rate.
Asana [https://app.asana.com/] is a simple free-for-limited use project management/checklist management tool. You can have multiple owners of projects, each project has checklists with tasks and sub tasks, conversations, a calendar, progress meter and files. It integrates with Dropbox and Box. You can assign tasks to people with due dates and attachments, and each person gets a dashboard. Premium at $7 per user per month gives you custom fields, task dependencies, private projects within your domain.
Be intentional with your use of social media to promote the bar and your initiatives. Hootsuite social media management [https://hootsuite.com/plans/free](https://hootsuite.com/plans/free). Manage up to three social media platforms for free, plus two RSS feeds to get content. See all of your platforms on one dashboard, schedule content (up to 30 messages in advance), see basic analytics and integrate other tools and apps you use. Get the [Hootlet Chrome Extension](https://chrome.google.com/webstore/detail/hoottlet/hohhfejhmijblcmcdkcojcdgfggjkfhh) to send out interesting content you see on the web in just a few clicks.
Tripit [https://www.tripit.com/](https://www.tripit.com/) is an online travel planner app that organizes all your travel plans in one place—for free. This service gives you on-the-go access that stores essential travel documents and contacts, auto-import of your itinerary, keep your travel plans and calendar in sync, and lets you share your plans. Simply create an account, get the app, and forward email confirmations from hotels, flights, car rentals and more. TripIt creates an itinerary with all the confirmation information, contact information and more. For $50 a year the app also alerts you to flight delays, alternative flights and more.
Don’t be that person sitting on the floor at the airport. Invest in a good battery pack that powers the devices you need so you always have a power source. Morphie
http://www.mophie.com/ makes some powerful and popular ones, but there are plenty to choose from:
https://www.pcmag.com/roundup/351446/the-best-battery-packs-for-your-phone
Best practices for use of Microsoft’s PowerPoint would suggest that words be used sparingly and at a minimum. However, sometimes you just need a bulleted list. But, it doesn’t have to be boring! Add your bullets, select the text and in the Insert tab in the Ribbon in the Illustrations group click on “Smart Art”. (Insert – Illustrations – SmartArt). Choose the option that works best for your list, choose your colors and apply. That way at least your bullets don’t have to be boring!